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The Joy of Tournaments User Guide for NSDA District Tournament Set-Up [BEFORE]

Things to do BEFORE an NSDA District Tournament

The following notes will help you have a successful first-time experience with the Joy of Tournaments.
The instructions that follow are far from exhaustive descriptions of each process. The Help option in
the software provides you access to well over 500 pages of documentation. The following notes are
geared specifically toward an NSDA District tournament whereas the help pages inside the software

contain a lot of information that may only apply to other tournament styles.

NOTE: This document is part 1 of a 3 part series for NSDA District tournaments.
Part 2 covers tasks DURING the tournament and part 3 covers tasks AFTER the tournament.

Use this as a checklist for things to do BEFORE the tournament:

. Download/Install/Authorize.

. Save your tournament.

. Configure the initial setup.

. Import website registrations.

. Assign codes.

. Create and copy the schedule.

. Add your rooms to the software / assign rooms to events.
. Set up NSDA rules and options.

. Create schematics for IE / Pair debate rounds.

10. If needed, assign judges.

11. If needed, add a judge, enter a school, or add a new entry.

OCONOOOARAWN-=-

Before the Tournament Process

1. Download/Install/Authorize.

A. Download the software on to your computer/update to the latest version.
Log in to your website and click on the red Administration link and then on Software
Download. Click on Full Version. (NOTE: If this link does not appear, email a request to
add the software to your order to: support@joyoftournaments.com.)

NOTE: You may safely download the software multiple times if necessary for your
tournament. The installation process will not harm your data if you have already begun
preparation for your tournament. The installation process only updates the PROGRAM
leaving your data untouched.

If you download the software more than 1 week prior to your tournament, it is highly
recommended that you repeat the process the week of your tournament to make sure that you are
running the most recent set of updates for your tournament.
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*  When you click on this link you’ll see the program downloading into the “downloads” folder.
Depending on your browser will depend on where you’ll find it, but you need to open your
download list and click on the Installjoy.exe file. If you see a File Download — Security
Warning dialog. Select the button labeled Run.

* The Setup process will start with a screen that says, “Welcome to The Joy of Tournaments
Setup Wizard”. This will give you the version number it’s trying to install and a
recommendation to close all other applications before continuing. Click Next, and follow the
prompt for installing.

* When the last box appears, be sure to click Launch The Joy of Tournaments and then click
Finish. The Joy of Tournaments should automatically open to the registration box. If not, click
on the Start Menu and open The Joy of Tournaments. (Follow the steps below to license the
software.)

B. License the Software Using the Registration Wizard.

The next step will be to enter an "authorization key". The presence of an authorization key will
convert the "trial" version of the software into the full version of the software. Without an
authorization key, the software will not allow you access to particular options nor will the program
allow you to print.

NOTE: If you have recently run a tournament, you’ll still need to get a CURRENT key;
otherwise, you risk being returned to “trial” mode when the older key expires.

* The software should open and you should see the registration box with the Machine ID already
in the Machine ID box. NOTE: If you have a current license, you may see the Events page
instead. To open the registration box, click on Help and then on Registration. Click the
Registration Wizard.

* When the next box appears, enter the email and password you use for logging into your Joy of
Tournaments website. Leave the bottom two boxes blank and click Get Key.

* You should be directed back to the registration box. The serial number and key will
automatically be placed in the appropriate boxes. Click OK. You will get a box that says,
Registration Succeeded. Click OK and that computer is officially licensed for your
tournament.
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2. Save your tournament.

A. Go to the File menu and select
Save As.

-

Save As

Save in: I.;} My Documents _vJ & & B3
NOTE: You should select a

' (& e Foider Il
location on your computer to i e Folder

save the data for your
tournament. It is recommended
that you do not save on a
network drive. It is also
recommended that you do not
save on a thumb drive. If at all
possible, it is recommended that

you save your work on the local File name: ~ |*tm Open
hard drive of the computer you
will be using for tabulgtion )I/t i Save as type: | Toumament Files [* tn) | Cancel I |

also recommended that you
create a separate folder on your computer to store the data. If you will press the Create New

Folder icon (ﬁ'), you can easily create a new folder. Rename the "new folder" to something
appropriate (e.g. "JOT NSDA DATA", or "NSDA Data" — or whatever name you need).

NOTE: You must REPLACE the
"*.trn" that will initially appear in Save n: [ 11 New folder <]« @k @

the "File Name" field with a file 7 i

name representing your Name Date modified Type
tournament (e.g. Anywhere
NSDA District Debate).

No items match your search.

B. To test that this step has been
completed successfully, EXIT the
application (select File -> Exit
from the menu). When you exit the
application, you should not see <l
any questions or prompts appear. Fiename:  [“tm
If you do get a prompt of any kind
on exit, one of the steps above
has not been completed
successfully.

Save as type: IToumament Files (*tm)
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If the program exits without any messages, you should then open it back up. The title bar of
the application should have the name of your tournament that you supplied earlier in this
process. If you see "Untitled Tournament" in the title bar, your data is not being saved properly.

IMPORTANT NOTE: From this point forward, you should never see a red flashing "save"
message in the status bar of the application. If you see this message at any time, you should
immediately STOP what you are doing and save your work. Any time the flashing red "save”
message appears, your data is not being saved.

3. Configure the initial setup.

The next step is to complete the "initial setup”
of the software. The steps listed here are the
most important steps you will perform. Click
on File -> Properties. You will see a screen
similar to the following:

A. Starting in the General tab, enter the title
of your tournament in the Name box as
you want it to appear on reports and
postings.

e Select the correct Start Date and End
Date — NOTE: Be sure these dates
match the dates on your website and
DO NOT SKIP THIS STEP.

* The rest of the defaults will be correct for
all of the other options on the General
tab.

Tournament Properties @

Backup every

Path

vV Reminders

™ Read Only

Sweepstakes | Judges | Options | Stes |  Fees |
General I Awards | Hostinfo |  Watematks | Deadlines |
Name (Untiled]

Start Date 2/ 92006 ~| ErdDate| 2/ 9/2006 |

I 15 minutes

|

[ SingleExpand Tree | LogAdds/Drops

I~ Letters in Codes IV Validate on Exit

oK | Cancel J
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5. Clck on the Host Info tab. Yo

will see a screen similar to this Sweepstskes | Judges | Options | Swles | Fees |
one. General | Awards Host Info I Watermarks | Deadines |
* In the School field enter the
location of the district School ]
tournament.
. L. Coach ]
* |n the NFL District box at the
bottom, enter the name of your E-Mail ]
NSDA District (e.g. "Tall Cotton",
"Lone Starv) School Phone ]
Home Phone |
Fax l
NFL Distrct |
| 0K | Cancel J Apply |
) ( " -y m
C. Next, click on the Styles tab. You | [oumament Properties
will see a screen similar to the General I Awards I Host Info I Watermarks | Deadlines I
fo||owing one. Sweepstakes | Judges |  Options Styles I Fees |

» Select NFL District Tournament. [ TFA toumamat

* If have special permission from [ FLA Toumament

NSDA to use this option, select [v' NFL District Tournament

Accelerated Elimination. [~ Accelerated Elimination [~ Bonus Qualifications [0
* Select California plan if you plan [ California Plan

to use this method of tabulation. [~ PhiRho PiNationals
* If your district has earned the [ EBEEL I oumament

Option of haVing bonus [~ CHSSA State Tournament

qualifications, select Bonus
Qualifications. In the box next to
it, indicate how many qualifiers.
NOTE: Enter the TOTAL number

[T NCFL Nationals

of slots — not the ‘extra’ slots) your oK | Cancel
district has earned.
* Press OK.
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4. Import events and website reg

istrations.

[BEFORE]

The website import will give you a head start on some of the following steps, so if you are doing
this setup work in advance of your tournament, you may repeat the import process again closer to
your actual tournament. Prior work on rooms and rounds will not be lost when importing data.

A. OPTION A: QUICK IMPORT

- Click on File->Import

Website Entries->Enter your
email address and password.

* A dialog box will appear that
is labeled, Web Import ->
Locate Data Files. The
default option, Download
directly from

joyoftournaments.com has

already been selected. Type
in your email address and

your password. Click Next. A

dialog box will appear
indicating the download is in
progress.

¥ Practice HS Tournament - The Joy of Tournaments

[Fite] Edit_View Reponts Heip

f
Generate Web Pages
Email Results
1Sampletm

2 07ncfipfd.m

3 playn

4 FAoplaytm

Exit

Set
Events

0 Everts

Entnes Sectons Goal Rooms

Standalone: 7.7.1

* The next box that will
appear is the Web Import
-->Map Events box.

¢ |[f there are no items in
the Unmapped Web
Events box, click Next.

NOTE: If there are any
events in the
“Unmapped” box, you
will need to tell the
computer how to match
them. The items on the
left in the Mapping box
are the ones that have
been created inside the

Web Import -> Map Events

S

Event Mapping

Unmapped Web Events

Event

Web Event

Web Event

Dramatic Performa...
Foreign Extemp
Domestic Extemp
Humorous Interp
Original Oratory
Duo Interp
C-XDebate

L-D Debate

Public Forum Deba...
Senate

House

The events listed
on the left are
Ithe ones that you
created inside
the tabulation

software.

Domestic Extemp
Humorous Interp
Original Oratory
Duo Interp

C-X Debate

L-D Debate
Public Forum

Senate
House

e

The events listed on the
right are the ones that
are on the website and

are trying to import.
The events on the right
need to match the ones
on the left.

International Extemp
Dramatic Interp

The events listed in

his area are the ones

that the website

doesn't find an exact

match for in your

tabulation software.

Click on the event
name to match it to
the correct event in
the next steps.

Cancel

tab software. The events
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in the middle of the Mapping box are the ones that are available on the website. The events

need to match in order to import correctly.

NOTE: An event will be unmatched if the names inside the tab software and on the website
don’t match exactly. For example, the website may have “International Extemp” while you
have created an event named “Foreign Extemp”. The “mapping” process helps the software
know that these two events are actually the “same”.

* To clear the Unmapped | Web Import -> Map Events [
Web Events box, double-
CI|Ck on one Of the |temS in Event Mapping Unmapped Web Events
the Unmapped bOX on the Event . Web Event WebEyenl l
. Dramatic Performa... International Extemp
rg ht. Foreign Extemp

Humorous Interp
Original Oratory
Duo Interp
C-XDebate

L-D Debate

Senate
House

Domestic Extemp Domestic Extemp

Humorous Interp
Original Oratory
Duo Interp
C-XDebate

L-D Debate

Public Forum Deba... Public Forum

Senate
House

<Back

l Next > | Cancel

* Another box will appear with a list of

Web Event: Dramatic Interp

i

potential events that match. Click on

the item that matches. If there are no
other names that are similar and you
need to create a new one, then click
on "new event". Click OK. Repeat this
process for each of the items that
need to be mapped.

<new event>
Dramatic Performance
Foreign Externp

oK

Cancel
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* Once the items are mapped,

Web Import -> Map Events

the “Unmapped” box will be

empty CI|Ck NeXt. Event Mapping Unmapped Web Events
Event | Web Event l Web Event
D tic Perft . B tic Int
* Repeat the above process as FOAER D L ok
needed for any unmapped Domestic Extemp Domestic Extemp
\ Humorous Interp Humorous Interp
SChOOlS. Original Oratory Original Oratory
Duo Interp Duo Interp
C-XDebate C-XDebate
H L-D Debat L-D Deb
* When the mapplng proceSS PubliceF:rjm Deba... PubliceF:rtjm
has been completed, The o o
Web Import-> Import Entries Oral Interpretation
box will appear. Click on
Begin Import. When the

download is complete another
box will appear to indicate that
the import is complete. Click

<Back | Next > | Cancel

Finish.

B. OPTION B: TWO-STEP PROCESS

Step 1: Importing the website entries from the website to a saved location on your computer.
Log into your website on http://www.joyoftournaments.com, and click on Administration. On the left

under the control panel, click on Export Data. Then, click on the option that says, Export Entries

(Joy of Tournaments Import Format).

* A page will appear that is titled, Export
Website Entries. Right click on the
blue link that says, Web Download
Definition (tourn.txt) and select, Click
on Save Target As. (Different
browsers may show different options,
i.e., FireFox users will see Save Link
As. Select the option that allows you to
save the file in a location on your
computer.

Website Export - In

| htp/wwwjoyoticumamentscom/tcents ~ | +» | x ¥ Google

W B v« @Conn. BW. X » e~ m ~ im0 v rPagev ) Toolsw

—

Sample Tournament

°
Dates: 9282007 - 232007
tournaments BB i omoond

Yiew Website + Account Home + Logout

Export Website Entries

Exporting tournament data

Export is complete.
The following e 1S necessary for the Joy of Tournmen(s File -> Import Website Entries option
Web Download Defintion (loum ) |

Doraniodd mstructons. nght chck on the lnk above and select the opton labeled "Save target as” 1o
download your toumnament rformation. Save the file on your computer's hard drive somewhere
(make sure 10 make 3 note of where you save the fie) You can then mpor the entres via the File -
> import Website Entries option withen The Joy of Tournaments PC tab software

Atermnatively, you may receve the file necessary for mporting nto The Joy of Tounaments via emad
¥ you would Bke 10 3o 50, (i the aggeopriate emad address below and press the button labeled

Send. Once you chck the send button, check your mbox for the emad. Since the file will come as an
attachment, you may find the emad blocked or marked as spam by fllers on your computer

Send emad 1o JoeCoach@poyclosmaments com (end) (k)

Click here for help with this option,

A AN ah Lo, an T gAY A T WA S A
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Once you select Save As, and select a location on to save the data. NOTE: As a default
setting, the computer will save the name of the file as “tourn.txt”. It is strongly
recommended that you do not change the name of the file. Click Save.

Step 2: Importing the website entries from a saved location into the tabulation software. Get
out of the browser, return to your desktop and open The Joy of Tournaments software program on
your computer. Click on File and then Import Website Entries.

A dialog box will appear that is Wieb Import -> Locate Data Fées . -
labeled, Web Import -> Locate

Data Files. Select the second

option that says, Load from ‘ ~ Download drecty Som joyoRoumaments com (s computer must be cosnected 1o e intermed

disk (data has been 5
downloaded separately from
the website and stored on
disk). Then, click Browse.

0 Load fom desk (dats has Baen dounlonded separatoly Rom Hhe webisde aad siceed on dak)

Data Fio Locascn Browse '

CRek heep f0¢ halp with hes 00800

n Open “

—_
Look in practce high school - i &3 cr O

When the Open dialog box appears,
find the file where you saved your

tournament data in the step above in : Date modit Type prem ace
Part 1. You are looking for a "tourn" file Soung
with the (txt extension). Click on Open. [ You are looking for a

"tourn™ file with a ("txt)
extension on the end of it

Note: You may need to change the

file type to “Text Files (*.txt). To do

this click on the dropdown arrow in Féa name On
the box, “Files of Type” and select N Facsottype = Concel
the text files option. '

Open 33 read-only

The Web Import — Locate Data Files
box will reappear. Verify that the address/location is correct in the browse field and click Next.

NOTE: Follow the remaining mapping and import process as directed above in Option A.
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NOTE: Sometimes, school servers or security firewalls prevent information from coming in from
the internet and may prevent your import. For further assistance and alternatives to this process,
visit http://www.joyoftournaments.com/help/webimport.htm for detailed instructions.

NOTE: By completing the above process you have imported the events and registrations for your
NSDA District Tournament. If you’re not using the website for registration and need help setting up
the events, you'll find instructions in this document -> Tab Software Training Notes.

5. Assign Codes

You will need to assign codes to schools AND students for your NSDA tournament (especially if
you’ll use the Up/Down Method). NOTE: Each school should be assigned a letter code.

A. Assign School Codes - There are two methods for assigning school codes.

OPTION A: You may have the software assign ‘b Assign School Codes léj
codes to the schools by right-clicking on the
Schools folder on the left-hand navigation tree and O \Lators (Slohebeti sehaslordion
sglect the Assign School Codes option. YVhen tr’]e i e Cancel
dialogue box appears, choose one of the “Letters _ ,

. (" Numeric (alphabetic school order)
options.

(" Numeric (random school order)

Edit School @

OPTION B: If you already assigned codes
to the schools as you have received the Code [E Name [WestildHigh Schod Close

entries, you can hand-enter each school
code. Select the Schools folder on the !
navigation tree, right-click and select :
Properties. The edit school dialog will | ST
appear and you'll enter the letter in the s [ 2 [ Eml |
|
l

Coach Phone (s) |

Addr 1 Phone (h] |

Cell |

Addr 2

Code box. &l Email
Notes
Division | ~| I Hashrmived [~
District l __] Squad Count
Region
I —] Trophy Points
Additional Coaches Affiliated Judges
Add
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B. Assign Student Codes - Once | scgian Contestant Codes -
you have the appropriate codes
assigned to each school, you Method oK
may then assign codes to each " Code + Letter
individual competitor. Click File Cancel
> Assign Codes. The Assign (_iGade+Bumbsr
Contestant Codes box will

(— Code + Initials
appear.

(@ NFL (xe uses unique code)
You may select any of the options

that best works for your district ChlELGRteRsLrne) DR RS
tournament. You may wish to select " Sequential Numeric

one of the two "NFL" options. Beginning with 100

NOTE about the NFL options: If " PRP Nationals

you select the NFL (xe uses unique
code), a cross-entered student will
have a unique code for each event
in which they are entered. If you use the NFL (xe uses 1 code) option, a cross-entered student
will have the same code for both events.

To view the how the codes appear for each student, select a specific school under the Schools
folder. You will see the students from that school appear along with their code in the right-hand
pane.

6. Create and copy the schedule.

Up/Down Method NOTE: You probably won'’t know your full schedule ahead of time, but you
should have at least a good idea of how the first two or three rounds of every event will run. You
can always change the schedule "on the fly", but it is recommended that you at least setup the
first two rounds up front.

California Plan NOTE: It is recommended that you set up all your rounds in the beginning since
the NSDA Manual outlines your schedule based on entries.

NOTE: The process of setting up the rounds "on the fly" is the same as it is to do it ahead of time.
If you'll set up a few rounds early, you'll at least be more familiar with the process.
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A. Create the schedule. On the
navigation tree on the left, select the |tk X
event and right-click on it. Click on
Rounds. When the box appears for
that event, double-click on the rounds Possible Rounds

to add them to the bottom Schedule Round 4 A Add| Bitnd
box. Round 5 L I
Round 6
Round 7

Basic Rounds IRoomsI Fees | Options | Misc |

o

- Schedule

Round | Date Time |
Round 1

Round 2
Found 3

* Double-click on the round at the International Extemp Roun
bottom to set the time and select the
options for your tournament. You will oK
see a dialog similar to this one. Click
OK.

Cancel

(o272 20

Next Round

Prev Round

[0g004M =

[~ Flight [~ Panel Judges I 1
[ Flip for Sides [T Auto-Flight Judages
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NOTES TO CONSIDER:

* This is where you will set the flighting and panels for each round. Repeat this process for
each round that you are ready to schedule for the event.

* This dialog changes in appearance slightly based on some of the characteristics that you have
selected about the event you are working with. For example, if you select Round 1 of a debate
event, the option to flip for sides will not be grayed out.

* The program compares actual dates and times internally to determine if two rounds occur at
the same time.

* To edit a round again, select the event and click the Edit button.

File Edit View Reports Help

*  When you click on the
event on the left, you

. B&alJ el 2|[an | [<anTimes> <] | | set|
will see the sgmmary 5 D?ZZMM Dramatic Interp 2
page on the right. resEsii 32 Entres

Advancing to Nationals: 2 entries

(21 International Extemp Individual Events

(Z2 Domestic Extemp
(20 Original Oratory

m

Review the schedule
to be sure it is properly

32 Outstanding

Tabulation rules have not been specified. Entry Fee: $10.00

displayed. Make sure
that the DAY of each
round is correct. Make
sure that the times are
listed correctly. If you
have any problems
with the schedule, you
may return to the
Rounds dialog again
to edit the dates and
times until the
summary page
appears correctly.

Humorous Interp
Duo Interp
C-X Debate
(1 L-D Debate
(2 Public Forum
7] Congress

#-(_] Schools

7 Judges

#-(_] Rooms

7] Sweeps

(2 Schedule

-] Actions

For Help, press F1

Speaker goal: 7

Round 1
5 sections currently required

Round 2
5 sections currently required

Round 3
5 sections currently required

Outstanding Entries
Alpha Academy
Beta High School
Chi Central High School
Epsilon HS
Gamma High School
lota Preparatory School
Kappa South High School
Mu Catholic High School
Nu Academy
Psi East High School
Sigma High School
Xi Central High School
Zeta High School

PLOWWaAaANaARRaINW

Friday 8:00am

Friday 10:00am

Friday 12:00pm

Standalone: 12.5.1555
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B. Copy the Schedule/Rounds to Other
Events - Since it is common that several
events will run with a common schedule, you
may copy the schedule from one event to
another. Right-click on the event and select
Copy Rounds.

Select the events that have the same
schedule from the list of events that appear
and then press OK to copy the schedule.

7. Add your rooms to the software /

assign rooms to events ;

A. Add rooms. To enter the inventory
of available rooms, right-click on
Rooms on the left-hand side. You
will see the Edit Room box appear.

Hall /
Building

Notes

Times

NOTE: You will only *need* to enter pate

the room number in the Name box

and then hit Enter. By default, the
rooms are ALWAYS AVAILABLE.
Enter times ONLY if the room has

. IV Prelims ™ Prefer I” Special Needs
a special schedule. ™ Elims ™ Avoid
I” Finals [~ Split

The only field that is required on this

[BEFORE]

Copy Humorous rounds

Oratory.

US Extemp
International Extemp
Duo Interpretation
L-D Debate
Policy Debate
Public Forum

Cancel |
Clear all |

Select All

|

Close

Availabilities ™ Unavailable

Friday v
Add >>
From 08:00AM - |

To  [07.00PM -

screen is the name of the room. The
name of the room should be listed the way you

want the room to appear on postings when this

room is assigned. Examples: Room 10, ZACH 304, JH 102. The names should be relatively
short (12 - 15 characters) although you may use anything you want. If you use longer names

for the rooms, there are some reports which wil

| not be able to display the full room name.
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* As you enter the rooms S—————
that are available, the 68 Von_ g 1ot _ ,
"Room Usage" report will | =om st : |5 fom
be updated to reflect Do
each room you have R
entered. "

S Room Usage

Paday CULACS

£00 9.00 10.0001 00so¢a 100 2.00 300 400 500600 700

* Continue entering rooms
until you have your room
list entered. If you leave a
room off, you may always
come back later and add
it, but entering the room
inventory early is a good
idea.

* Should you need to make
a correction to a room
(correct spelling, change
the times the room is : ‘ ‘ >
available, add notes, — —
etc.), you may do so by moving your mouse over the name of the room in the right-hand
window (where the Room Usage report appears). As you move your mouse over the name of
the room, the room name will turn blue. When the room turns blue, right-click and select
Properties from the menu.

B. Assign rooms to events. After you have completed the room inventory list, you may begin
assigning rooms to specific rounds and events. To do this, go to the events folder on the
navigation tree and find an appropriate event. Right-click and select the option labeled Rooms.
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* A dialog box for the event will appear.

At the top of the dialog next to the | Domestic Extemp i
Round is a drop-down list of the
rounds you have scheduled for the Basic | Rounds Rooms |Fees | Options | Misc |
event. Select the appropriate round
from the list. Round | |
* Alist of the rooms that are available
during the time frame you have Rooms
indicated for the specific round of the Room 20 . 17
event will appear on the left-hand side Room 21 13
of the dialog (under the heading of Roome? 3
. . . Room 23
Rooms. A room is available if no M o New
other event is scheduled to use the Room 25
room at the time specified for this Room 26
round and the room has not be Room 27 i —J
indicated as unavailable at that time. Show C Al (& Available
* NOTE: At the bottom of the dialog
there are two radio buttons. One is ok | cancel

labeled All and the other is labeled
Available. Initially, the radio button labeled Available will be selected. When the Available
option is selected, the left-hand list will only contain the rooms which are not in use at the
same time as the round you have selected at the top of the dialog. If you select the All option,
the left-hand list will show all rooms from the inventory of rooms regardless of availability. It
should only occasionally be necessary to switch over to the All option.

* The rooms that appear on the left-hand side are color coded to provide you with additional
information about the rooms. The color code is as follows:

Background Color Meaning
White Room is available for use
Room has not been indicated as appropriate for this specific round
Black VAT
although itisn't in use
Red Room has been marked as Unavailable
G Room is in use by another event at the time this round is
ray
scheduled
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" dinplay each of th rooms tat you
display each of the rooms that you have [imis

selected for use during the selectt_ad Basic | Rounds Rooms I Fees | Options | Misc |
round. To move a room from the list on
the left-hand side of available rooms to :
. ) Round  |Round 1 Fri 08:004M
the right-hand side of selected rooms, | °Lfn _ = ".
there are two options: 39 Entries: 3 sections of 5 x’ 4 sections of B
Speaker goal of 7 requires 6 rooms
v' Select the room on the left with Rooms Selected Rooms (7)
the mouse. When the room has Library A | Room 116
been highlighted, press the >> Portable 1 I Eﬁgmng
button in the center of the dialog. Portable 2 Room 115
Multiple rooms may be moved Portable 3 Niss | Room 117
together using this method. Portable 4 , Eggm Hg
v' Double-click on a room in the EEE:H? ................... | _,Ed't
left-hand list of rooms. S I View |
NOTE: To remove a room that has been Show € Al (¢ Available
selected for use (in the right-hand list of
rooms), S|mply reverse the process oK Cancel |
(double-click on the unwanted room or

click on it and click the << button.

* Repeat this process for each round of the event until all needed rooms appear in the Selected
Rooms list on the right.

* If you wish to double-check the room assignments for an event, you can easily return to this
view by right-clicking on the Round then click on Rooms.
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° NFL SAMPLE - The Joy of Tournaments
File Edit View Reports Help

C. Understanding the

%?:;Zdugligzg_age - A Hig=sE| 2 <an -1 [<anTime -] [ | set| [ca>  ~ ;
=3 Events Z
H H H (2 Ballot Status Room Usage <
indicates the room is ; Friday, 03/07/08 p
. (3 International Extemg b
being used. You can 8Domesﬁc Extemp 8:00 9:00 10:0011:00noon 1:00 2:00 3:00 P
. . &3 Original Oi kS
quickly see which rooms  © Siooemes | ® Roam 1 : %
are in use and which o Sl b Room3 A
) ) (3 Duo Interp p Room4 y
rooms are still available &G C-X Debate p  Room5 ¢
. . . i R 6
during different periods g PO b sﬁﬁﬁ; %
of time. If a room has & Rooms 5  Roamg hS
=3 Judges R 10 b
been over-scheduled @8 Actions 5 Roons P
. . R 12 :
during one of the time g E EEEEB g
periods it is in use, the 3 Round 3 p  Room 15 3
b . O Round 4 p Room16 £/
ar representing that & Round 5 P Roam 17 P’
. . . . oom .
time period will be red. e b Room 19 5
The bar for a room will Qoweroffiisn | b Rogmot S
. . (3 L-D Debate p Room22 B
also appear in red if the & Public Forum P Room23 ¢
room has been marked =~ ® Dschools b Room25 /
, &3 Judges p Room26 <
as Don’t Use. If a black & Rooms P Roomar 3
bar appears, it 50 b Room29 g
‘ ) ~ . R 30
represents an ‘extra 2 Actons - sﬁgﬁg; 3
room that is available at b Room33 :
that time. but has been PLSIINT P s Lt 9 JROPOS g [T 1
assigned to a particular event.
. ? NFL SAMPLE - The Joy of Tournaments
* You can view the File Edit View Reports Help 7
assignments for a Bislals]e] 2 fan ~] [kanTime ~| | | set| [can>  ~ ¢
specific room by pausing "™t Room Usage
over the room's name & International Extemg Riieay N 4
Wlth the mouse. When ggz;::;zﬁ;p 8:00 9:00 10:0011:00noon 1:00 2:00 3:00 i
you hover over the room, £ Humorous Interp - sl 3
a tip will appear listin G IR RARD p  Room|L
p pp g (3 Duo Interp p  Room|Prelims OK 7
each of the assignments =0 C-X Debate p  Room |Fri 08:00AM International Extemp Round 1 7
. (2 Entries p Room (Fri 10:00AM International Extemp Round 2 £
fOI’ the room. Th|S - Cross Entries S Sggm Fri 12:00PM International Extemp Round 3 [~ ;
C Fri 12:00PM H I Round 3
example shows the bt P RO et ey Ko ‘
assignments for Room 1 £ Actions B  Room-2ueB0EMI DIDEbaEfinss 7
where a red bar is o] b Room 13 ¢
ind.icating a conflict. @ founa3 it /
This example shows a e e
conflict with room 1. = Q3 inals b Hoomin
. . 2 Awards B
When viewing the (22 Order of Finish g S‘;?,Q 5? 7
assignments you will see ©L-D Debate P Room22 /
that at noon a round of e b Room 24 7
/"DA/ASfP/O(/JIS/ VAWV VSV et e /g/ SRV S S f""'r T TGP PN AN A “:/‘)

HI has been
inadvertently assigned to the same room at the same time the IX round is scheduled there.
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To easily substitute or

[BEFORE]

v_ NFL SAMPLE - The Joy of Tournaments

File Edit View Reports Help

reassign this room, right- <
. B sals el 2|[an <] [<allTime ~ | Set| [cany | 3
click on the Room (onthe [ e ¢
. . . & Bal Room Usage ,
right-hand side) and click Ballgt oty Friday, 03/07/08 z
. (3 International Extemg P

on ASS|gnments. @01 Domestic Extemp 8:00 9:00 10:0011:00noon 1:00 2:00 3:00 /
=0 oOriginal Oratory | */,

Pl s :

i P p Rool Assignments... N

(3 Duo Interp p  Rool ’

=3 C-X Debate p  Rool Delete 5

(3 Entries p Rool . %

(3 Cross Entries P Roo s Ava!!able ;

B R p Root ¥ Prelims ¢

v p  Rool Elims 4

O Judges p  Rool - y

(3 Actions p Rool H

& Round 1 p Rool Preferred s

O Round 2 B sgg Avoid 3

=~ Round 3 S Roo! Split 7

(3 Round 4 p Special Needs >

[ Round 5 p 7

&3 Finals p <

2 Awards z "

(3 Order of Finish p ;

(3 L-D Debate p <

(3 Public Forum p &

@[ Schools p ;

Vuprrag PRt S

When the Room Assignments box
appears, click on the event you wish to
reassign. The options on the right will
become active. Select Substitute.

NOTE: If you wish to remove or move all

assigned rooms, you may select those options

as well. This example will show how to
substitute a room.

When the Room Substitution box
appears, select the appropriate room and
select OK. The Room Assignments box

Room Assignments

Room 1

Time Cancel
Fri 08:00AM International Externp

Fri 10:00AM Interational Externp Add
Fri 12:00PM International Externp

Fri 12:00PM Humorous Interp Remove

Sat 02:00PM International Externp
Sat06:00PM L-D Debate

Mowve All
Assignments

Humorous Interp

Round 3

Substitute

will reappear. Verify that the event disappeared and click OK again.
On the Room Usage page, the red bar will have disappeared.

Page 19 of 19

Before the Tournament Guide

Revision: Fall 2015



The Joy of Tournaments User Guide for NSDA District Tournament Set-Up

NOTE: You may also filter
this Room Usage page to

? NFL SAMPLE - The Joy of Tournaments

[BEFORE]

File Edit View Reports ’.{

view only certain days of E@Qﬂﬂmmime I | set] [can>  ~ <
(3 Event: <al> 3

your tournament. For usZEZS.s Fi:ida , 03/07/08 ROFQdm oljo?/oasge S
example, if you are running 2 Judges Saturday. 03/08/08 e 7
a tWO'day (Frlday & 2 'ﬂf[fjooh/’:;sp 8:00 9:00 10:0011:00noon 1:00 2:00 3:00 ,:
Saturday) tournament and e Al s
you only want to view the £ by Time S e z
(3 Unscheduled Room 5 £

Saturday _Rooms, you may e Y B :
do so. Click on the drop- % 02 Sweeps B Roang p
(3 Schedule g i 5

down arrow at the top of @ Actions P e
the page (just .to the left of E s 4
the “Time” option). The P Room13 pt
p Room 14 3

dates of your tournament B (Homiis 8 ¢
PRGIPIN PSP ST RIN G N Do iGN pron g N P2 s AP

will appear. Select the date
you wish to view and the Room Usage view on the right-hand side will change to reflect your
requested date.

* Another option for
viewing room

.~ NFL SAMPLE - The Joy of Tournaments N . 3

File Edit View Reports Help
H(&(m[J[E| 2| [can ~| [<all Time <] set| [ca> ~

A A A

assignments is to use ) Room Grid
the room Grid. To view 5% B o i m R
thls grld’ Open Up the SS::?’“B‘“ Room 2 X X X X LD :
rooms folder and click on o Room3 X [ x | A ;
G rid 3 Unscheduled Room 4 DX DX DX DX DX DI P
- =3 by Name Room 5 DX DX DX DX ¢
- Sweeps Room 6 DX DX ¢
. & SC"?:“'G RZZm 7 00 | oo | oo | oo 00 | oo 00 :
NOTE: This feature may P Room8 00 | 00 [ 00 | 00 00 | % 3
. . Room 9 00 00 (e]e) 00 B
also be filtered to view only Room 10 o0 [ 00 [ o0 2
certain days of your s ol Rl B 7
tournament. For example, if oS [ WECWIC. v L $
. oom >
you are running a two-day Room 15 A A
(Frlday & Saturday) Room 16 DI DI DI DI DI DI /
Room 17 DI DI DI DI DI DI P
tournament and you only Room 10 ME N ot [ z
want to view the Saturday Room 20 b | o o | o p
Room 21 DUO DUO DUO DUO DUO ,’
RoomS, yOU may dO SO. Room 22 DUO | DUO | DUO DUO ¢
i Room 23 puo | buo | pbuo b4
Click on the drop-down Room 28 oo ovo :
arrow at the top of the page Room 25 o [ ox [ox [ ex o | ox {
. . @ Room 26 CX CX CX CX CX CX £
(JUSt to the I’Ight Of the J y Room 27 =3 cX cX ox cX ;
“E” and ye”OW “?” bUttonS NS\ 2SN //RGTng’ 228 g0 Sk /CX o n s CX 13( (I;‘XI’ aIANSTH r 27 17T g2 50 ot /i

and to the left of the “Time” option). The dates of your tournament will appear. Select the date
you wish to view and the Room Usage view on the right-hand side will change to reflect your
requested date.
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8. Set up NSDA rules and options. Add Event
|n Ordel’ fOF the eventS tO tabU|ate Basic | Rounds I Hooms | Fees | Dptions MiSC l
according to NSDA rules, you will need to
select the necessary options for each Tabulation Method | ~|  Edit.
event. To do this right-click on the event Prelim Ranking Rules ggg Edi..
and select Properties and then Misc.) Ballot Stle FLA [2005] —_1]
NOTE: Repeat these options for each FLA (Original) ‘
event.) NFL Type EEEL% |

Duration (in minutes) PBCFL oints -
A. Set the tabulation method. From the S s r PFD i
dropdown menu next to Tabulation il L |TFA
Method, select NFL. NOTE: You Entire Fiound Wi 0
should IGNORE the "Prelim Ranking
Rules". Speaker Goal ] 7 Copies 0
-
B. Choose the ballot style.
» For each IE event, there is a specific o8 Garesd I £pply

NSDA ballot. Next to Ballot Style,
select the appropriate NFL ballot.
Print IE ballot. Open the Event folder on the left and then right-click on the round folder.
Then select Print All Ballots.

For Public Forum select Debate — Team Points from the dropdown menu.

For Lincoln-Douglas and CX Debate select Default from the drop down menu.

Print Debate ballots: Open the Event folder on the left and then right-click on the round
folder. Then select Debate Ballots. You may add notes (e.g., the topic) in the Message box.

You should IGNORE the Single Performance and Entire Round "duration" fields. The
defaults (indicated by a zero) are sufficient. You can safely IGNORE the minimum and
maximum speaker points because for NSDA districts all that is necessary is a win/loss record
in debate.

You should IGNORE the speaker goal because the speakers per section is outlined by the
district tournament manual and the software knows about the chart. DO NOT check the "All
ballots form virtual panel for finals" option. Click OK.
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C. Set miscellaneous options.

* Next, you will click on the Options tab.
Depending on the event will depend on
what options are not “grayed out” and
are available for use. For Dramatic
Interpretation, Humorous Interpretation
and Duo Interpretation you will need to
select the Track Selections option.

* For Public Forum, you will need to select
the “Label Aff/Neg as Pro/Con (Public
Forum)” and “All rounds flip (Public
Forum)” options.

[BEFORE]

Humorous Interp Properties

Basic I Roundsl Roomsl Fees Options lMisc I
[~ Track Selections e scinty
— [ AllPlacings
[~ Exclude Results [ Non-Placing
[T TFA Sanctioned =
[T Allow ties for last place on ballots
o [v Complete
l— Map ranks greaterthan b to b P
|_ abel AfffNeg as Gowv/Opp (Parli)
[~ All rounds flip (Public Fc | [ C
[~ Elim breaks notroom-based [T Me
[_ [N
OK | Cancel |

Public Forum Properties

Basic ] Roundsl Roomsl Fees Options lMisc I

[ Track Selections - Award Script

[ OmitNames on Ballots [~ AllPlacings
|~ Exclude Results [~ Non-Placing
[T TFA Sanctioned .

ml [v Complete

| Label AfffNeg as Pro/Con (Public Forum)
[~ All rounds flip (Public Forum) [T Ciglflc |E

o |

Cancel
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9. Create schematics for IE / debate rounds.

[BEFORE]

Up/Down Method NOTE: The first two rounds will be automatically created since they are

already pre-set.

California Plan NOTE: For the California Plan, the first round is pre-set. Because the second
round is powered off the first round, the second round will be created after all ballots have been

entered.

A. Create Sectioning for Individual Events or Debate - To create sectioning or pair an event,

right-click on the specific round of the event.

For IE, choose Create Sectioning:

2 2006 NFL District Tournament - The Joy of Tourname

File Edit Yiew Reports Help

Haa el 2] [,

=T

= [ Events
(2] Ballot Status
(2] Humorous
+ [ Entries

[ Rooms
+ (] Judges
(] Actions
SRS [Round o
+ (] Round
+ (] Round
+ (] Sweep!
(] Awarde
(27 Dramatic
(23] Oratory
(23 US Extemp
(2] Internatior
(2] Duo Interp
(L] L-D Debate
(27 Policy Debé
&[] Public Foru
1 [ Schools
1 [ Judges
1 [] Rooms
1 [] Sweeps
(1 Schedule
+ [ Actions

FOEE O F

o

+ (] Cross Entries

Print Postings
Print All Ballots
Edit Header | Footer Text...

Envelope Labels...
Ballot Labels..,
Judge Cards...
Entry Cards...

Manual Judge Assignments. .,
Auto Judge Assignments
Judge Restrictions

Unassign Judges

Find...

Rooms
Properties
Enter Individual Ballot. ..

| Create Sectioning

Adjust Cross Entries

Re-Label Round

For Debate, choose Pair:

006 N Distric

H& =l |E

ournament - Ihe Joy of lourn|
File Edit VYiew Reports Help

=[] Events

[Z] Ballot Status
L:] Humarous
(] Dramatic
(] Oratory

([ US Extemp

- [ - [ [

+ [ L-D Debate
= [ Policy Debate

(] International Extemp
+ [_] Duo Interpretation

Room

+ (L] Entries
+ (] Cross Entries
(2 Rooms
+ (] Judges
(L1 Actions
L | S
+# (] Rounc Print Postings
+ (] Rounc  Debate Ballots
+ (] Sweep  Edit Header { Footer Text...
(2 Aware
o) E}Jﬁ( Fort Ballot Labels, .,
- (3 Schools Judge Cards...
(3 Judges Entry Cards...
# Eé‘ Rooms Enter Ballots...
i E—,‘ Sweeps Power Detail...
i Lf' Sch.edule Manual Judge Assignments. ..
# (0 Actions Auto Judge Assignments
Judge Restrictions
Unassign Judges
Find...
Rooms
Properties

Pairing Priorities. ..
Round Robin...

Re-Label Round
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* For IE, a dialog similar to the following
should appear. If needed, modify the
numbers to reflect the number of
sections you wish to have, and click

OK.

Dramatic Interp

Entries Cancel

Prelims

Sections

Speakers

7 speakers: 5 sections (2 with 7, 3 with B)
B speakers: B sections [2 with B, 4 with 5]

8 speakers: 4 sections of 8

*  When creating a debate paring a dialog similar to the following should appear. Select Yes to
create the debate pairings.

Action Confirmation

Create Debate Pairings

Yes

No

Cancel I
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* For IE, a schematic similar to this one will appear:

[BEFORE]

Eil

Edit View Reports Help

H&salJ[e]| 2|[<an

] [<anTimes> -] |

| set

B+ Events
i..[] Ballot Status
...[1] Ballots Due

(2 Domestic Extemp
(I Original Oratory
-0 Humorous Interp
=L Dramatic Interp
(] Entries
-] Cross Entries

(] Rooms
@-(1 Judges

(1 Actions
-3 Round 1
-] Round 2
() Round3
(1 Prelim Results
(2 Sweeps

[ Awards
-1 Duo Interp
@-(C] C-X Debate
- L-D Debate
-] Public Forum
-] Congress
- Schools
-] Judges
[
[

7] Rooms
a3 Sweeps
(1 Schedule
- Actions

-] International Extemp

n
NS ;oo =

10
13

15
19

20
1

13

5 sections missing a judge

Section 1 - Room 110
Carolina Reighner
Madison Faast
Henry Eiserman
Laz Grant
Skye Cable
Ester Demuth

Section 3 - Room 112
llan Kranz
Hazel Wade
Nick Inez
Jordyn Painter
Garland Hawkins
Angelia Hughes

Section 5 - Room 301
Stewart Jackson
Nick Lyons
Taneka Leonard
Greg Ewing
Betty Graff
Meagan Wilson

Dramatic Interp

Round 1
8:00am

19
15

20

13

15

20

19

Section 2 - Room 111
Freddy Bloise
Kory Munson
Vanessa Todd
Ethel Coveney
Isadore Gibson
Tristin Thomas
Hazel Vorrasi

Section 4 - Room 113
Ruby Schneider
Elizabeth Dennis
Shania Ruhl
Frederick Ulery
Dawn Merryman
Zachary Taggart
Martha Napier

NOTE: You may edit your schematic on the left by dragging and dropping the students to
different rooms/sections.
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[BEFORE]

* For debate, the pairing will appear on the right side of the computer screen and look
something like this.

file Edt View Reports Help

ﬂldln JE _!J [(.all} 'I [<NI Tine -] { ] _Se_tj
e L-D Debate -
&3 Ballot Status
» 3 Humorous Interp Round 1
» 2 Dramatic Interp 12:00am
» 2 Foreign Extemp
» 3 Domestic Extemp
% 23 Original Oratory X : |
= 3 Duo Interp Room Affirmative Negative
® —'C'; m“m“ Room 129 2 Woana imsin & Kim Kershal
- _' l.
e Enxm" Room 130 2 Emily Ervens 8 Rupert Robertson
-3 Cross Entries Room 131 3 Ursula Urther 5 Freddy Finch
2 Rooms Room 132 1 Ashiey Adams 7 Orpheta OReily
= Jludges Room 133 8 Quinlan Queen 6 Jenny Jenkins
: ' Room 134 6 Linda Luther 4 Harmis Herckshel
® < fo 1 |
3 Round 2 Room 135 1 Brent Butterworth 8 Sara Sheeley
% C3Round 3 Room 136 5 Dorrve Davis 2 Herman Hemandez
= 3 Round 4 Room 137 2 Fernando Femandez 5 Eric Erickson
. jg;""““";""‘ Room 138 8 Peler Patierson 4 Gina Ginger
= o-FHinals
5 G2 Quarter-finals Room 139 3 Tina Tohler 7 Mindy Mendleson
+ (23 Semi-Finals Room 140 7 Nita Nuden 1 Derek Danels
= LI Finals Room 141 3 Violet Victor 2 George Gherens
® O Sweeps 1 Charles Cuttervilie BYE
3 Awards
= 2 Public Forum
= 2 Congress \
= _JS('\OO‘S
* (0 Judges 1
= 2 Rooms
= 2 Sweeps ‘
23 Schedule
=@ Actions

NOTE: You may edit your schematic on the left by dragging and dropping the students to

different rooms/sections.
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[BEFORE]

10. If needed, assign judges - There are two ways to assign judges. You may automatically assign
judges or you may manually assign judges.

NOTE: The website will only allow for entry of “school-affiliated” judges. If you didn’t use the website,
or if you need to add hired or volunteer judges to the tournament you may do so. (See the

Addendum section at the end of this document for details.)

A. Automatically Assign Judges - To automatically assign judges, double-click on the event to
display each of the rounds of the event on the tree. Right click on a Round and a dropdown

menu will appear. Select Auto Judge Assignments.

¥ Practice HS Tournament - The Joy of Tournaments

file Edit View Reports Help
G @mlJe| 2l
= 2 Events |
& Ballot Status
&3 Humorous Ir
» J Entnies
& Selection
» 3 Cross Ent
& Rooms
» J udges
- Actions

e Print Postings

Gy Print ANl Ballots

P Edit e / Foot

-5 fin Edit Header / Footer Text.
= OSw Ervelope Labels.

I An Ballot Labels._

# 3 Dramd Judge Cards.
= A Fforeig

Entry Cards
= 3 Dome
= (3 Origi Manual Judge Assignments_
= J0luol
= XDy

= QL-0DD Unassign Judges
= Public Check Selections..
= Congress

¥

= (3 Schools e

= O Judges Rooms

= 2 Rooms Sweepstakes.

= Sweeps Properties

Rl S TN S Py Y

Section 1 . Room 121
1 Laureen Link

Section 3 - Room 124
pcks

Humorous Interp

Sectic

2 Michedie Ma
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*  When the Assign Judges dialog appears, click OK. You may wish to change some of the
options as displayed on this dialog to modify the judges that are considered in the assignment
process. The Assign Judges dialog box will something like this one:

* The schematic will appear on the right and will now display the assigned judge names.

* NOTE: This does not
automatically assign judges to
all events and rounds
simultaneously. Repeat this
process for each round of each

event.

‘ Assign Judges

Public Forum Round 1
Friday, 01/27/2012 04:00PM

Sections Priority

Required ' Rating
; 'B' Rating
Available © Rating
‘D' Rating
'E' Rating
Check-in
Coach

Preferred

Panel Size

Lag Minutes

Student Judge

— Options

[v Retain currently assigned judges

I” Do not move judges
IV Observe round limits
|7 Consider 'dirty’ if seen in anather event
[V Avoid Judge Tracking a Squad
I” Assign coaches
[” Assign 'hired' judges
I” Ignore judge blocks
I LimitJ udaing Influence by District

0 a single round of this event

ges pre-assigned to later rour

1ds In this event

™ Assign 'dity' judges

[V Assign unconfimed judges
[V &ssign judges not checked in
[V Assign 'Student Judge' judges

I Maximize panel diversity

[one ballot)
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B. Manually Assign

Judges for DEBATE —
There are two ways to
manually assign judges:
Via the navigation tree or
via the schematic.

Via the navigation tree -
Right click on the Round
and click on Manual
Judge Assignments.

When the Manual Judge
Assignment dialog
appears, you may make
changes to that round.
(See instructions in the
next section.)

Via the Pairing (Debate)
Find the room/section on
the pairings of the event
you want to assign
judges. Right click on one
of the student names.
When the dropdown

menu appears, click on
Manual Assign Judges.

¥ Practice HS Tounament - The Joy of Tounaments

File Edit View Reports Help

Qsimlse] 2| [

-1 [cmiTime ~1
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Set

[BEFORE]

@ Congress udge Restrictions

£ Schoots Unassign kxdges

23 Judges

23 Rooms Find_.

2 Sweeps Rooms

S S Sweepstakes..

# 2 Actions e

Manual Pair_
Paic
Pairing Pricrities.
Round Robin..
Re-Label Round

Tt L-D Debate 2
2 Ballot Status
-2 Humorous Interp Round 1
# &) Dramatic Interp 12:00am
2 Foreign Extemp
42 Domestic Extemp
& & Oniginal Oratory
523 Duo Interp Room Affirmative Negative Judge
4 S C-X Debate Room 129 4 Kgoina imsin 6 KimKenshal Thomas Tears ("3)
ey Room 130 2 EmilyEnvens 8 Rupert Robertson Glenn Gungho (*3)
4 2 Cross Entries Room 131 3 Ursula Unther 5 Freddy Finch Anita Applewaite ("2)
=) Rooms Room 132 1 Ashiey Adams 7 COrpheta OReily Doug Drewman (*4)
S Jdges Room 133 8 Quinian Queen 6 Jenny Jenkins Josh Juniper ("4)
] Room 134 6 Linda Luther 4 Maris Honckshel Zebra Zonith (*8)
! j Roun  Print Postings rent Bultenworh & Sara Sheely Jery Jkang (°6)
o D Roun  Debate Baiots onnie Danis 2 Herman Hemandez Bary Barmhardt ('6)
@ S Roun  Edit Header / Footer Text. emando Femandez 5 Eric Enckson Bne Benthere (1)
’ j z; o' 8aliot Labels.. eler Patierson 4 Gina Ginger Charies Cupeppes ('6)
2 Qus Judge Cards.. ina Tohler 7 Mindy Mendieson Cathy Catwilher (*5)
b sem| Y Card jta Nidest 1 Derek Dariels Beth Beatty ('2)
o SyFinal  Enter Ballots fiolet Vicior "2 George Gherens “Wikma Winner (1)
> Eharles Cuttervile BYE

Standalone: 7.7.1 NUM

¥ Practice HS Tournament - The Joy ¢

File Edit View Reports Help

of Tourname

nts

IEIEIENI R T -] [<at Time ~1 Set]
B L-D Debate
<) Batlot Status
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o S Jdges Room 133 8 Quinlan Queen 6 Jenny Jenkins
= Actions
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5@ Round 2 Room 135 Brent Butterworth LR [ e
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9-E0 Prelim Results Room 138 & Peler Pallerson 3 nual
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* Viathe
Schematic (IE)
Right click on
one of the room

B
7

£
(1] Ballot Status 4‘/
numbers or over -3 Ballots Due RounHz! 7
=[] International Extemp 4:00pm &
one Of the (2 Entries el
[ Selections 4
SUdent COdeS- (L Cross Entries Section 1 - Ropm 101 Section 2 - Room 102 /
21 Rooms Judge: Carla Clayton ('R) Room... 5
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dropdown menu - 3 A11| lan Eden NewEntry.. A15  Eunice Godfied S
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on Manual 23 Round 3
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(&) Practice NFL District Toumname

File Edit View Reports Help

e Joy of Tournament

[BEFORE]

ESEE AR

| [<anTimes> -] [

| set

=] Events

3] D Duo Interp
7] C-X Debate
=} (1 L-D Debate

-

/A ST s\

International Extemp
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*  When the Manual Judge Assignment dialog appears, you may make changes to that round.

* Note what section
of this round you

o Iml Judge Search [~ Search Assigned Judges 08:00AM Saturday
are editing and Ford [roraT 3] Now | € &
. 4 Unassigned
. - Possible Judges (37)
change sections,  |ffe== - BN
H I™ by Bracket i< anonymous judge> i |
if needed. If you — 2 Alan Alberison (*C) P »
come In via th e ~Judge Search Filters Edit Code | Name
. fo e GO5  Lamy Boxer
pa | rl n g O r rOO m y Assignments C43  Louise Wildman

you’ll start with
the section you
right-clicked on;
otherwise, the
default setting is

. . 1 Greg Grey [*S)
start with section - 2 George Guyer (')
ide ing" Ju 0 Paul Picker (*H)
One . School Affiliated Judge 0 Peter Piper [*H)
0 Patricia Pourier (*H)
G 0 Rachel Radimer (0)
nclude Non-obligated 2 Raphael Ramiriz (*Q) "’{3‘0" by-
B m 2 Roger Reyes (*Q) * Last Name
0 Ralph Rizjak (*Q) " First Name
District | any Az 0 Rory Rodriguez (*Q) L8 |~ Code
N 0 Stacey Sharebox [*N)
Ratng  [ary ] 0 Steve Smitty (N) " District
Flag any A 05tan Steer (*N) " Region
# Assignments | |0 Tory Tambia (T) " #Rounds
0 Thomas Tank (*T) .
Min Ma ~ | Prioity

Round 1 L-D Debate Judges 08:00 AV

<1 SRR ENEL =1 <SS ED L E SR

a ore [C

2 Billy Bob (*J)

0Bob Brown (4] *

2 Brenda Brown (*J)
0 Chris Carter [*R)

0 Christy Chapman (*R)
1 Carla Clayton [*R) *

1 Geoffrey Geuryer [*S)

2 Tim Teeboat (*T)

Restrictions

History

Billy Bob ()

Possibl
S M1 M2 ¥3

Swaps

B
(|
=
[ EEmp |
il

-

E

CX, LD, PF
(J Beta High School) [3 entries]

Public Forum Round 1 Friday 04:00PM Section 7 Room 107 (Flight 1)
Public Forum Round 1 Friday 04:00PM Section 8 Room 107 (Flight 2)

|n— [99—” Update | |
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* Note the
competitors to
whom you wish to
assign a judge. If
you click on one of
the competitors,
you will see the
details of that
competitor in the
box on the right.

* Choose ajudge
from the
Possible
Judges box.
When you click
on a particular
judge you will
see the details
for that judge in
the box on the
right.

I by Bracket

I~ Apply Filters

~Judge Search Filters
I™ Include Judges no
I™ Include
™ Include

ncanfimed Judge:

on checked-in Ju

¥ Include Non-obligated

Event  [1.p Debate -
Round  [Round 1 v
Section

Bectont ]2

Judge Search

Possible Judges (37)

[~ Search

" Unassigned

<anonymous judge>

2 Alan Albertson (*C)|

[ C)

2 Billy Bob (*J)
0Bob Brown (%) *

0 Chris Carter [*R)

0 Christy Chapman [*R)
1 Carla Clayton (R) *

1 Geoffrey Geuryer (*5)
1 Greg Grey [*S)

2 George Guyer (*S)
0 Paul Picker [*H)

0 Peter Piper *H)

0 Patricia Pourier (*H)
0 Rachel Radimer (Q)

L .

B 2 Roger Reyes (*Q)
Aegon ey 0 Ralh Riisk (0)
Distict ~ |any 0 Rory Rodriguez (*Q)
" = 0 Stacey Sharebox [*N)
Raing oy ] 0 Steve Smity (N)
Flag any 0 Stan Steer [*N)
L # Assi 0 Tory Tambia [*T)
0 Thomas Tank (*T)
2 Tim Teeboat (*T)

2 Brenda Brown (*J)

2 Raphael Ramiriz (*Q)

2l | & UnPooked

g

Edit

Assignments

Restrictions

History

Possible
Swaps

m

|
(e
===
|
il

GoTo

Assignment

~Sort by
@ Last Name

" First Name
| € Code
" District
" Region
" #Rounds
« | O Priority

» |

[BEFORE]

Assigned Judges 08:004M Saturday

=

Larry Boxer
Louise Wildman

-

V1

CX, LD, PF
(J Beta High School) [3 entries]

Public Forum Round 1 Friday 04:00PM Section 7 Room 107 (Flight 1)
Public Forum Round 1 Friday 04:00PM Section 8 Room 107 (Flight 2)

Event

L-D Debate 2
Round  [Round 1 <
Section  [5ection 1 v

I~ by Bracket

I~ Apply Filters
~Judge Search Filters
™ Include Judges not in event Pool
I Inclu ol Restricted Judges
I™ Include Judges Dirty in Event
I Include Judges Ditty
™ Include Ju

Region |any .

District ~ |any A

Rating m

Flag any M
- # Assignments

Hin Max

Judge Search

Possible Judges (36)

<anonymous judge>
3 Alan Albertson (*C)|

0Bob Brown (%) *

0 Chis Carter [*R)

0 Christy Chapman [*R)
1 Carla Clayton [*R) *

1 Geoffrey Geuryer [*S)
1 Greg Grey [*S)

0 Paul Picker [*H)

0 Peter Piper [*H)

0 Patricia Pourier [*H)
3 Raphael Ramiriz (*Q)
0Ralph Rizjak (Q)

0 Rory Rodriguez (*Q)

0 Stacey Sharebox [*N)

0 Steve Smirty [*N)

0 Stan Steer [*N)

0 Tory Tambia (*T)

0 Thomas Tank [*T)

| 3 Tim Teeboat (*T)|
0 Tara Treatier (*T)

m

Possible
Swaps
GoTo

Assignment

~Sort by-
Last Name

oY

Search Assigned Judges 08:00AM Saturday
& A . 3 Brenda Brown (%) Cancel
" Unassigned
" Un-Pooled —‘ml Judge
- 1
B > 2
Edit Code | Name 2
GOS  Lamy Boxer 4
Assignments C43 Louise Wildman 5
Restrictions 7
8
History 9
10
Raphael Ramiriz (*3) X 1

V1 [v2 v3

** Judging in section 2 () **
CX, LD,
(@ Rho North High School) [1 entiy]

Public Forum Round 1 Friday 04:00PM Section 11 Room 109 (Flight 1
Public Forum Round 1 Friday 04:00PM Section 12 Room 109 (Flight 2
L-D Debate Round 1 Saturday 08:004M Section 2

- L-D Debate Debaters Seen -
J18 Sierra Woollard (as Aff) Round 1
TO7 Pansy Jowers [as Neg) Round 1

First Name
Code

District

This box shows information about the
judge's assigned pool, school details, and
assignment history.

# Rounds

o
[
'@
" Region
I
(@

Priority
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* If this is the judge
that you wish to
choose, double-click
on the judge name.
The selected judge
will appear in the
box labeled,
Assigned Judges.
Click OK.

NOTE: This dialog offers
other options. See the
diagram below for further

descriptions.

Event  [L.D Debate v
Round  |Round 1 <
Section  [Section 1 <

I by Bracket

I Apply Filters
~Judge Search Filters

Region |any ¥
District ~ any Y
Rating any -

Flag lh

- # Assignments —

Judge Search

Possible Judges (36) il

[~ Search
@ Al
" Unassigned
" UnPooled
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0Bob Brown (%) *

0 Chris Carter (R)

0 Christy Chapman (*R)

1 Carla Clayton (*R) * E

1 Geoffrey Geuryer S)

1 Greg Grey (*S)

0 Paul Picker [*H)

0 Peter Piper (*H)

0 Patricia Pourier (*H)

0 Rachel Radimer (Q)
3 Roger Reyes (*Q)|

0Ralph Rizjak Q)

0 Rory Rodriguez (*Q)

0 Stacey Sharebox [*N)

0 Steve Smirty [*N)

0 Stan Steer ['N)

0 Tory Tambia (*T)

0 Thomas Tank *T)

Il 3 Tim Teeboat (*1)
0 Tara Treatier (T) 2
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Edit

Assignments
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History

Possible
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Assignment
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Last Name
First Name
Code
District
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# Rounds
Priority.

@ @0 @ @ e

[BEFORE]

05:08&M Saturday

3 Brenda Brawn %))

Code | Name
GO5  Lary Boxer
C43  Louise Wildman

Raphael Ramiriz (3]
V1 V2 V3

Cancel

Judge

HG&GNA

-0 W~

&
- -

** Judging in section 2 () **
CX, LD

(@ Rho North High School) (1 entry]

- L-D Debate Debaters Seen --
J18 Sierra Woollard (as Aff) Round 1
T07 Pansy Jowers (as Neg) Round 1

Public Forum Round 1 Friday 04:00PM Section 11 Room 103 (Flight 1
Public Forum Round 1 Friday 04:00PM Section 12 Room 109 (Flight 2
L-D Debate Round 1 Saturday 08:004M Section 2

You will be able
to specify more
paremeters for
judge criteriain
this section.

egion

tict | any >

any ¥

any ¥
any hd

Rating
Flag
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ir

-

0 Christy Chapman (*R)
1 Geoffrey Geuryer (*S)
1 Greg Grey (*S)
3 George Guyer (S}
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0 Peter Piper (*H)

0 Patricia Pourier (*H)
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0 Ralph Rizjak (*Q)
0 Rory Rodriguez (*Q)
0 Stacey Sharebox (*N)
0 Steve Smirty (*N)
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0 Tara Treatier (*T)

m
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I earch Fiters 0 Alice Alverno (*C) Edit Code | Name —| the students in
This option [ Include Judges not in event Pool Dylan Buehler this section.
i 0 Julie Ambrose (*C) Assighmenl lan Eden
altlows y‘:;: to 0 Alex Anaya (*C) ] Ancno Doormare f
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particular section,

the number of that
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When you click on a

First Name

P
" Code
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" Region
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-

Click one of these
options to sort the
Possible Judges list.

judge the
information about
that judge appears
here in this box.

Priority
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[BEFORE]

11. Addendum - If needed, add a judge, enter a school, or add a new entry.

A. Add Judges - NOTE: You may only need this option if you are entering non-school affiliated
judges (hired or volunteer); otherwise, you can skip this step if you have imported the entries

from the website.

The website will only allow for entry of “school-affiliated” judges. Judges not affiliated with a
school will need to be hand-entered.

If you didn’t use the website or if you need to add hired

or volunteer judges to the tournament you may do so by right-clicking on the Judges folder on
the navigation tree on the left and select Add.

The Edit Judge box will appear. While this dialog has numerous options, the only field that is

required is the judge's name. All of the other fields reflect additional information that you may
use to assist you in the process of contacting, recording, and assigning judges.

Edit Judge

PR X
atihacn as i
Name | v| Change | Home |
Abhbr (. by Code ® Name ‘Work [ Close
School [<none> | Cell I Restrictions
Region | _l Pager l
District I J E-mail l
Note |
Ewvents Times
International Extemp - Availabilities [ Unavailahle
Domestic Extermp Date |Fr|day l_’
Original Oratary HEERE
Humorous Interp Fraom 08:00 AM =
Dramatic Interp = |
Duo Interp 3 -
C-%X Debate i |03‘DU BN 1
L-D Debate
Public Forum
# Rounds 0 [v AsNeeded |Narmal v
Obligation Base Priority Rating v
[v' Any Event :
Private Note |
[ Confirmed [ Don'tUse [ Stop Using
[~ CheckedIn [~ Coach
[T No Show [v Prelims
[~ Hired [v' Elims
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* Each of the fields on this dialog is described in the following table.

Field Description

Name The name of the judge. This is the only required field for defining a judge.
Each judge must have a unique name. This name will be displayed on
ballots and postings where judge information is provided. Typically you
will want to provide full names, as in John Brown, and Julie Smith, but
you may use whatever names you desire (for example, last name only).
Code The judge code. Options exist in various places to display a judge code
instead of the judge name. If you want to use those features, you must
provide a code for each judge. The code can be anything you want it to
be. It is recommended that you use a short code (3-4 characters).
School This field allows you to record a school affiliation for the judge. By
recording the affiliation, you are automatically recording a judge
restriction; they will not be scheduled to judge competitors from the
affiliated school. Additional restrictions may be coded for the judge. The
affiliation field is used to record the primary affiliation. If you are requiring
that judges be provided by each school, use this field to record the
school that receives the credit for providing the judge.

Region Use this field to indicate the region the judge represents. If you are
attempting to balance judges by region, the software will use this field.

District Use this field to indicate the district that the judge represents. If you are
attempting to balance judges by district, the software will use this field.

Note This field provides a customized note for each judge. The note will

appear on assignment sheets given to the judge. You may provide
personalization to your assignments using this field. Examples: Hey Joe,
stop by the tab room — | have a trophy for you from last week’s
tournament, or Thanks for judging Mary.

Phone Primary phone number to use to reach the judge.

Work Work phone number of the judge.

Phone

Cell Cell phone number of the judge.

Phone

Pager Judge's pager number.

Email Use this field to record an email address that may be used to reach the
judge.

Events The events this individual may actually judge. Initially, the Any Event

check box will be checked indicating that the judge may be scheduled in
any event. If so, the list of events will be disabled. If Any Event is
unchecked, then the events highlighted in this list represent the events
for which the judge may be scheduled.

Any Event | If checked, indicates that the judge may be assigned to any event for
judging.

Date / Use these three fields to indicate when a judge has indicated they will be
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Field Description

From/To | available. You may then press the button labeled Add >> to move the
availability into the list of times the judge is available (labeled
Availabilities). You may remove an availability by highlighting the time in
the list and pressing the button labeled Remove.

Unavailable | Use this checkbox to indicate that a judge is not available for any judging
slots.

# Rounds | Maximum number of rounds for which the judge should be scheduled.
This box will be disabled if the As Needed box is checked. The
application will honor this limit when instructed to do so. You may over-
ride the limit by making assignments manually or requesting that the
limits be ignored when automatically assigning judges.

As Indicates that the judge may be used for as many rounds as needed. In
Needed other words, this indicates that there is no maximum number of rounds
allowed for the judge.

Normal / If you have indicated that the judge be used As Needed, this field

Light / provides an additional level of priority for using the judge. Light indicates
Medium / | that the judge should be used as few times as possible; Heavy means as
Heavy many times as possible. Medium indicates the judge should be used

slightly more than Normal, but not excessively. Normal is the default.
Obligation | Use this field to record the number of rounds the judge is obligated to

judge.
Base Judges are assigned based on a priority system. Judges normally start
Priority out with a priority of zero. If you want to favor this judge for assignments

(that is, place them in more rounds), assign a base priority for the judge
greater than zero. The priority scale by default runs from zero to
approximately 100. Higher numbers result in more assignments; lower
numbers result in fewer assignments. You may also assign a negative
number to reduce the likelihood of assignments for the judge. The actual
judge that is assigned to each slot is based on a number of things. When
all other considerations are equal, the software assigns the slot to the
judge with the highest priority.

Rating Use this field to rate the judge. Ratings are based on a scale from A to E.
A represents the best rating.

Private Use this field to keep a private note. This note will only appear on this

Note dialog. You may keep notes here that you would not necessarily want the

individual to see. For example, Avoid interp events, Argumentative.
Caution is advised not to over use this field.

Confirmed | This field may be used to track judge confirmations. After receiving a
confirmation for the judge, check this box. If you choose, confirmed
judges may receive a different priority for judge assignments than
unconfirmed judges.

Checked You may use this field to track which judges have Checked In or that you
In know are present at the tournament. When assigning judges, this can be
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Field Description

used to alter priority for assignments.

No Show | This field may be used to indicate that the judge is a No Show.

Hired Use this field to indicate that a judge is hired. Extra options exist within
the software for hired judges to assist in payment.

Don't Use | When this field is checked, the software will mark the judge as being
completely unavailable. The software will not assign judges with this
attribute set. Additionally, you will be warned if you attempt to assign a
judge that has been marked Don't Use. Use this field primarily to indicate
that a judge previously thought available has become unavailable for

use.

Coach This field allows you to mark the judges that are coaches. You may use
this field to alter the priority of assigning coaches as judges.

Prelims If checked, indicates that the judge may be used in Preliminary rounds. If
unchecked, the judge will not be assigned to preliminary rounds of
competition.

Elims If checked, indicates that the judge may be used in Elimination rounds. If
unchecked, the judge will not be assigned to elimination rounds.

Stop When this field is checked, the software will stop assigning the judge for

Using additional rounds. Any existing assignments will be retained, but the

software will not automatically add any assignments to the judge.
Additionally, you will be warned if you attempt to assign the judge after
marking them with the 'Stop Using' flag.

* NOTE: Additional flags may appear on the bottom of this dialog if you are using user-defined
judge flags (these flags were set up in the initial website preparation process). User-defined
flags will appear following the 'Stop Using' flag.
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*  When you return to the
judge page (click on
Judges) to view the

judge list, the

hired/volunteer names
will have a special
code next to the name
to indicate they are

hired.

B. Add a school. Right-
click on the Schools
folder and select the
option labeled Add from
the dropdown menu.
Selecting this option will
bring up the dialog that
appears. This dialog
allows you to store the
information about a

school.

* There are only two fields
on this dialog that are
required: Code and
Name. The remaining
fields are all optional.
Use the chart below to

determine the

information that you may
enter in the different

fields.

[BEFORE]

v_ NFL SAMPLE - The Joy of Tournaments

File Edit View Reports Help

(3 Actions

Tim Timmons (*D)
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[BEFORE]

Using this dialog, you may enter the appropriate information for each school. Be sure to press
the button labeled Enter. This will store the information you have entered for the current school
and clear the dialog for entry of the next school. When you have finished with the dialog, press
the button labeled Close.

Field Description

Code A short code that will be displayed to represent the school on all reports. It can be
numeric, alphabetic, or anything else you want; however, the code you choose
should be short — typically 1 or 2 characters. For NSDA districts, school codes are
typically alphabetic.

Name The actual name of the school or squad. Typical values are Friona, Friona High
School, Texas A&M University, Amarillo High Gold Squad, etc. This is a descriptive
name of the team. Result pages generally display the name of the school.

Coach The name of the (primary) coach or sponsor for the school.

Addr 1 First address line.

Addr 2 Second address line.

City City that the school represents.

State State

Zip Zip Code

Phone Phone number of the school.

Fax Fax number of the school.

Home Coach’s home phone number.

Phone

Email Coach’s email address.

Notes A text field that allows you to keep short notes about the school. This field does not
appear on any reports.

Has Used to mark a school as arrived. The arrival status may be tracked during

Arrived registration allowing you to know which schools have/have not checked in.

Squad Number of competitors from this school. This number is used in the calculation of

Count squad efficiency. If you leave this number blank, the application will automatically
calculate this number. If you supply a number here, the number you supply will
over-ride the automatic calculation.

Trophy This option is only available for NSDA District Style tournaments. Record the

Points trophy points retained from previous district competition in this field.

Additional | A list of additional coaches for the school. Use the Add and Remove buttons to edit

Coaches | the names on this list.

Affiliated | A list of judges that have been coded as affiliated with the school. Used primarily to

Judges determine if a school has provided sufficient judges.
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C. Add a new entry. There
are multiple ways to enter
competitors in the
software. Here is the
recommended process for
manually typing in the
entries.

* Go to one of the events on
the navigation tree (it really
doesn't matter which one
you select). Open up the
Events folder to reveal the
"entries" folder beneath it.

° 2006 NIL District Tesrnament - The Joy of Tosrnaments
e BN Wow Poporls e
Bsim|se| 2| = K | —
= = Fvwees ~
e i Humorous
o Mo 0 Ertnee
4
# ClCong M

4+ ] Dun Isterpretaton
« ) LoD
= 1) Polcy Detacs
+ ) Pubke Parum
* (2 ook
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= (2 Roors
() mveen
) Sdwde
= 2 Actene

Bachup i progeee.

Shaccakorm: 6.1 950

Right-click and select Edit from the context menu.

* From the School dropdown menu, select the appropriate school from the list. (If the school is
missing, you may use the "Add" button to add the school; see the previous section for

information about adding
a school.)

Entries by Event

School I

> Add. |
Devine High School (&)

Eagle Mountain High School (F
Falmouth Hiah Scheal (B h
Event  |}arion High Schaol (E]
Rochester High School (D]

Contestan\westfield High Schoal [C)

!

Squad Members (&ll)

Close |

- Sort / Search by

@ FistName  © LastName
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* From the Evnt cropdown

menu, select the appropriate
i cl |
event from the list. School  [Falmouth High School (] ~] Add. | =

Sot by Name " by Code

Event ]Humorous L]

Humorous
Contestary Dramatic

[_ Oratory

US Extem)
Squad Mg Dua Interpretation pous entries [0)
L-D Debate

Palicy Debate
Public Forum

i~ Sort / Search by I I ]
@ FistName LastName : -

* Type in the name of the
contestant in the field labeled Entries by Event
"Contestant Name".

School | Falmauth High School (B ] Add. | Close |

Sot  * byName " by Code

Event Ilntemalional Extemp _Y_i

Contestant Name

|John Doe

Squad Members (&ll) International Extemp entries [0)

i~ Sort / Search by iz J
* FistMame " LastName ‘ '
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* Press the Enter key on the
keyboard (some keyboards label
the key "return"). This will cause
the student's name to appear in
both the Squad Members box on
the left-hand side and in the right-
hand box labeled "International
Extemp entries" (or whatever
event is selected).

* Continue with this process to
enter each of the students from
the School/Event combination you
have selected. You may change
to a different event and/or a
different school as you process
additional entries.

* The Squad Members list will
include all of the students from
the selected school that are
entered in any event.

* The Entries list in the bottom
right-hand box will list just the
students from that school that are
entered in the selected event.

Entries by Event

[BEFORE]

Schoal | Falmouth High School (B)
Sot [+ byName

~] Add. | _ e |

" by Code

Event |lnternali0na| Extemp

Contestant Name

|

Squad Members (&)

John Doe

i~ Sort / Search by
% First Name

" Last Name

E3|

International Extemp entries [1)

John Doe

LA

Entries by Event

Schoal IFaImouth High School (B)
Sot [+ byName

~] Add. | _ e |

" by Code

Event  |Dramatic

Contestant Name

||

Squad Members (&)

Alan Brown
John Doe
Mark Williams
Shelia Smith

i~ Sort / Search by

 FistName T LastName

E3|

Dramatic entries (1)

John Doe
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As a reminder, these instructions are not intended to be exhaustive of the entire software
program. They are meant to guide you through your NSDA District Tournament. For a more
specific explanation of these steps, refer to the manuals found on
www.JoyofTournaments.com/help/.

For software support, please call 806-773-0162
(available via Monday to Saturday).
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